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1. Set-up 

 
THIS PRODUCT MUST BE EARTHED 
 
1.1. Mount the DVR in a suitable rack mount system, supporting it at the rear as well 

as at the front. Ensure there is sufficient ventilation around the unit. 
1.2. Connect the power supply.  Note:  we highly recommend connection to a UPS 

(uninterruptible power supply) to prevent data loss. 
1.3. Connect audio and video input.  We recommend that the best quality input is 

connected i.e. the feed should be 1V pk-pk and come directly from the camera or 
via a good quality video distribution amplifier. 

1.4. Connect audio and video output. 
1.5. Connect VGA monitor. 
1.6. Power on. 

 
IMPORTANT:  Please plug in and switch on all video and audio input connections 

before switching on the DVR. 
 
 

2. Introduction 
 
The NETmc Marine Digital Dive Log (DDL) software is a software based event log 
and media controller allowing the management of a variety of NETmc Marine DVRs, 
with the option of controlling other NETmc Marine equipment 
 
The events are actuated by use of a set of multi-functional buttons which can be 
individually configured with frequently used commands, hardware actions and 
workflows to enable the user to complete a set of tasks in a consistent and orderly 
fashion. The DDL software also generates "Dive Reports" in Docx and HTML 
formats, with optional hyperlinks to media files in the HTML report. 
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3. Overview 
 
3.1. Hardware 

 
The DDL software will work with several NETmc Marine DVRs including DVR 
Inspector, HD DVR Inspector, X-Ops and the DDL-R. The 73fifty is not 
supported directly; however it can be controlled when used in conjunction with a 
DDL-R. 
 

3.2. Software 
 
The DDL GUI has 22 configurable eventing buttons and two non configurable 
event buttons. Each of the buttons are multifunctional and can be independently 
configured to do either one or several of the following; instigate a media file, 
cause the event to be labelled as an anomaly, or instigate a Work flow instruction 
and outcome e.g. Take CP stab and record the value. 
 
If a button instigates a media file, either a video recording or a still, the media 
file can be seen being generated in the “Record Control” panel, from where, if 
clicked, the media can be reviewed. 
 
At any point in a Dive, the user can generate a report, this is done in the 
“Publish” tab, several reports can be generated, and these can be either in .docx 
format or as an HTML report. There is a bundled HTML with embedded 
hyperlinks to the media files. HTML reports are viewed in Internet Explorer. 
 
NOTE: The DDL software can run without a video input, however the 
media controls will not work without a relevant composite video input. 
 

4. File Structure 
 
The DDL software is a “Project” driven package, a project could be the inspection of 
a single asset or a year long drill support project. Within each project there can be 
one or several dives (max 999), all the log entries and media files are stored in the 
relevant Dive files which are then stored in the associated Project folder and data 
from all Projects are stored in a master Root folder. 
 
NOTE: There is an automated file structure in the DDL software, do not delete 
folders or files without contacting your ROV manager for advice. The file 
structure is such that, changes to the global configurations must be made prior 
to creating a project. If a project is open when the configuration is made, the 
changes to the configuration will only apply to that project. 
 
When delivered a root folder called “DDL Projects” will already be set up on the 
“Data” (D) drive. 
DO NOT CREATE PROJECT FILES OUT WITH THE ROOT FOLDER. 
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5. Description of GUI 
 
The GUI is split in to five main areas, the Video Display in the bottom right hand 
corner, the Eventing Buttons, the Recording controls, the Log Table and the Tabs 
line. 

 
5.1. Event Buttons: There are 22 standard configurable “Event” buttons on the left of 

the screen, all DVRs will have a default “demo” set of buttons configured which 
can be overwritten with a company specific configuration. It is also possible to 
save several button files (button.dbf).  These files will also be called button .dbf 
but will have a friendly name when loaded into the database. These saved files 
would have to be saved in an appropriate folder. 
 
Below the 22 buttons are two extra buttons, firstly the “Add Time Event" button, 
this can be used to record a pending event e.g. watching the lowering of an 
anchor so the exact time of touch down can be recorder; the "Add Time Event" 
window can be kept open all the time.  
 
The second button is the “Add Manual Log Entry” this allows on the fly events 
to be added that are not already on a pre-programmed button, such events are 
just logged as Manual Event in the log table. However, it is possible to launch an 
“Edit Manual Event” window to complete the event details straight away, this is 
set up in the “Configure” tab, see more in later chapter. 
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5.2. Recording Controls: On the right hand side of the screen are the recorder 
controls; a different section for each of Record (Master recording), Clip, Stills 
and Playback. All controls can be operated manually or via clicking on a suitably 
configured Event Button. Each section is split into two areas, the operational 
area with clickable controls and a display area where the most recent files are 
displayed; clicking on any of these files will make them play in the Video 
Display area. Whilst the recorded media is being played there is no display of the 
"live video". 
 

5.3. Video Display: Media, including live video; video replay and stills, is shown in 
the Video Display in the bottom right hand corner of the screen.  
 
Tip; there is an option to have a larger Video 
Display in the middle of the GUI, if this is 
enabled then, when replaying recorded media, 
the live video moves to the bottom right hand 
corner video display. More details on this are 
given later in the manual. 
 
 
 

5.4. Log Table: In the centre of the GUI is the Event Log Table, this is a list of the 
events and is updated as buttons are clicked. 
 
The content of the Log Table is dependant on the way the system has been 
configured, but basically, it displays at least one line every time an "Event 
Button" is clicked. Other entries will depend on the set up of the systems and 
may include logged entries of “Video Loss” or “No Encoder”. 
 
The columns in the "Log Table" are also selectable, right click the title of a 
column and select the parameters for display. 
 
If a log entry has an associated media file then this file can be played by right 
clicking on the file and clicking the appropriate command. 
 

5.5. Tab Line: This displays the current dive log project/dive information and the 
various Windows Tabs used to set up the system. 
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6. Getting started - file structure 
 
As supplied a new DVR will already have the "DDL Project" folder set up on the 
"Data" (D) drive this is where ALL DDL project and dive data will be stored.  
 
NOTE: DO NOT create another root folder, there should only be one "root" 
location. 
 
 
6.1. To check your DVR has this file right click on "My Computer" on the desk top 

and expand the "Data" drive by clicking the + sign you should see the "DDL 

Projects" folder as below: 
 
 
 
 



 

NETmc Marine DDL software Manual  Rev1  July 2015       8 of 47 
© NETmc Marine Ltd 2013 
 
 

6.2. Now double click on the "DDL Projects" folder, this will show files that were 
automatically loaded during the setting up of the "DDL Projects" folder; see 
below. 
 

 
 

DO NOT DELETE OR ALTER THESE FILES WITHOUT 
CONTACTING THE ROV OFFICE STAFF 

 
 
6.3. Close Windows Explorer 

 
6.4. Double click on the desktop short cut to "DDL" to open the DDL GUI.  
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6.5. Click on the “File” tab then on “Select Store Path” in the drop down menu 
 

 
 
 and navigate to the “DDL Project” folder as below. 
 

 
 
NOTE: the file name “root.dbf” is auto-generated  
DO NOT CHANGE THIS FILE NAME 
 

6.6. Click on the "DDL Project" folder and click "Save" 
 
NOTE: These files are used as templates for the projects and dive files  
DO NOT DELETE OR AMEND THESE FILES 
 
We are now ready to configure the DDL software. 
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7. Configuring the software 

 
In this section we will look at how to; 

• set file durations and pre-recording durations 
• investigate optional functions 
• learn about  Events 

 
7.1. DVR selection and configuration 

 
The DDL software can be used with a range of DVRs so the first thing to do is to 
check the software is configured for your DVR. 
 

7.1.1. Click on the “Configure” Tab  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
then select "Video Encoder Configuration" from drop down menu; a new 
window will pop up as below. 
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7.1.2. The correct tab for your DVR type should already be displayed, if not 
click on the tab associated to your DVR type, for the X-Ops select the tab 
associated to the specific X-Ops channel required. 

7.1.3. Select the Signal Source of the camera 
7.1.4. Select the encoder format. 

 
NOTE; Selection of the encoder format may be decided by the client’s 
specification, the companies standard settings or the application. Also some 
encoder formats may require specific codecs. 
 

7.1.5. Select the Encoder Quality 
7.1.6. The “Use Remote Encoder” is for future use; ignore this. 
7.1.7. Video Recording Mode; What's the difference?  

 
If you click "Single File" the DVR will generate one long file for the 
duration of the recording; if you click "Multi-Files", and set a duration in 
seconds, then the DVR will create a set of chapters of the same duration e.g. 
300sec = 5min. 
 
WE STRONGLY SUGGEST YOU SELECT "MULTI-FILES" 

 
Check with your ROV manager if there is a client or company designated 

setting for above 
 

7.1.7.1.Clip Recording Mode 
 

7.1.7.1.1. When a clip is taken, either manually or by the pressing of an 
"Event Button", you can let the clip duration be controlled 
manually “NO LIMIT”, this will generate very long files if you 
forget to stop the clip. Clicking “LIMIT CLIPS TO” and selecting 
a duration in seconds, ends the clip after the predetermined time. 

 
WE SUGGEST YOU SELECT THE "LIMIT CLIPS TO" OPTION.  

 
Check if there is a client or company designated setting for this 
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7.1.7.1.2. When a button is clicked that actuates a "Clip" the beginning 
of the clip may be lost, this is just down to reaction time. DDL 
allows you to start the clip some time before the button was 
clicked by up to 4seconds. Click "ADD PRE-RECORD" then 
select the desired pre-record time. 

 
 
 

Check if there is a client or company designated setting for above 
 

 
7.1.8. If you have more than one DVR with which you use the DDL software 

e.g. a multi-channel X-Ops, you may want to configure each DVR 
differently. Once you have done this you can than just use the “Select Video 
Encoder Source” option in the “Configure” tab to select your DVR; see 
below. 
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7.2. DDL Optional functions 

 
There are several options that can be set for the DDL software start-up condition, 
store paths etc, so lets look at these in turn. 
 
Click on the “Configure” Tab and select “Options” you will see the screen 
below. Here is a description of each section. 
 

  
 

7.2.1. Start up options; 
 

7.2.1.1.“Open Last Project”; if this box IS ticked then the software will open 
“in” the same project as you were in when you closed the application. 
If it IS NOT ticked, the software will open with no project selected. 
 

7.2.1.2.“Open Last DIVE”; if this box IS ticked then the software will open 
“in” the same DIVE as you were in when you closed the application. 
If it IS NOT ticked, the software will open in the project but will need 
you to select a dive. 
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7.2.1.3.“Show Tooltips”; this allows you to turn on and off tips that appear in 
parts of the software when you hover the mouse over them. 
 

7.2.1.4.“Disable Split Preview/Log – Show Only Log”; by default the DDL 
software has a large video viewing area above the log table, as seen 
below: 
 
  

ticking this box will remove the video screen and extend the log to the 
top of the page.  
 
If you do not tick this box, it is possible to click and drag the log table 
up the screen, in doing this the video area will decrease proportionally, 
as shown below: 
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7.2.1.5.“Show DISK Space in LogOnly Mode”; with the “Disable Split 
Preview/Log – Show Only Log” box ticked; this function allows you 
to display the available space left in the allocated storage device as a 
fraction of the original space capacity. 
 

7.2.1.6.“Single Project Event Button Configuration”; Each Project can have 
its own set of buttons if you want the Project buttons to apply to all 
dives tick this box. 
 

7.2.1.7.“Single Project Encoder Configuration”;  
 
NOTE: This is not applicable to the DDL-R. 
 

7.2.2. Store Path (Base Folder Containing Projects); 
 

7.2.2.1.LOCAL: From the factory this will display "D:\DDL Projects" unless 
changed by user. 
 

7.2.2.2.REMOTE;  
 
NOTE: This is not applicable to the DDL-R  
 

7.2.3. WORKFLOW LOCKS AND CHECKPOINTS 
 

7.2.3.1.Log Entry Time Format; the DDL software times each system and 
user event to 1000th of a second, this allows the events to be logged in 
the correct sequence if multiple events happen at the same time. 
However the format can be changed for display purposes here. 
 

7.2.3.2.“Always Edit MANUAL Log Event After Capturing METAData”; 
There is an “Add Manual Event” button on the main GUI, just below 
the 22 buttons, this is used for on-the-fly adding of events,, basically 
unexpected events. If you tick this box, using the "Manual Event" 
button will automatically open a new screen that allows you to edit the 
description of the "Manual Event" there and then. If this box is left un-
ticked, the text "Manual Event" will be entered in to the log. 
 

7.2.3.3.“Do not allow Partially completed Workflow events in Log"; with this 
box ticked the operator is forced to perform a "Workflow Event" or at 
least "Do it Later" with it un-ticked he can ignore the "Workflow" 
requirement by clicking "Apply" 
 

7.2.4. “Remote Controlled Devices (mediaNET General Purpose Control 
Module Support)”;  
 
This applies when using a DDL-R, this section allows for the enabling to 
trigger up to two external 73fifty DVRs via a 12V source in the DDL-R. 
This area is for information only and is greyed out. Ignore this section if 
you do not operate 73fifty DVRs. 
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Click "Close" after applying any changes made. 
 

7.3. Events Description 
 
An "Event" is created each time one off the Event buttons on the GUI is pressed. 
Each event is allocated a unique two-digit alpha-numeric code and a description; 
these will be used in setting up the button configurations.   
There are two main types of events “System Events” and “User Events".  
 

7.3.1. System events  
 
These are mostly used in the back ground of the system; checking the 
operation of the DVR hardware or the video signal e.g. if a button is 
configured to start a clip, then a system event called “clip start” or “CS” 
will be logged in the back ground. These events can be displayed in the 
log file but tend to clutter up the log and so it is not recommended to 
display the majority of them in the log. However, some system events 
might be useful to be displayed in on screen log e.g. “Video Signal Lost” 
or “VL”. See below for table. 
  
 

NOTE: It is envisaged that only a designated system manager would 
configure the “System Events” or add a new “System Event”. 
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7.3.2. User Events 
“User Events” are created by the user, these are related to the operation in 
hand e.g. Visual Inspection or Taking of CP readings etc. associated codes 
could be VI and CP. The system checks all new codes to ensure they are 
not duplications of existing codes.  
 
The Events configuration is done under the "Configuration" tab, select 
"Customise User Events". 

 
7.3.3. To create or edit a “User Event”, click the “Configure” tab then 

“Customise User Events”, you will see a table with two default events, 
“EV” and “XX”; these cannot be deleted but can be edited. All events 
buttons default to “EV”, this will become clearer when we look at Button 
configuration. There will be two further events in the table,  “WI” for 
“ROV in Water” and “WO” for “ROV on surface prior to recovery” , 
these are just examples left in and CAN be deleted if preferred. 
 
 

7.3.4. The best way to understand creating user event is to make one; let’s create 
a new “User Event”, called “CR” and give it a description of “Crack 
Found”. 
 

7.3.4.1.Click the “ADD” button and type “CR” in the “EVENT” window 
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7.3.4.2.Now type “Crack Found” in the “DESCRIPTION” box.  
 
Now let’s look at the properties we want to allocate to this event type. 

 
7.3.4.3.Ticking “INCLUDE IN LOG” will populate the log table with the 

description programmed in to the button to which we allocate this type 
of event, so we will nearly always want to tick this box. 

7.3.4.4.Ticking “IS ANOMALY” will flag this type of event as an anomaly; 
finding a crack would generally be considered an anomaly so we 
would tick the box if appropriate. 

7.3.4.5.The DVR can be hooked up to a NETmc Marine videoTXT overlay, if 
it is then the DDL software can send text to the screen, we call this 
“On Screen Display” or “OSD”. If we want this event type to be 
displayed in the video image then we would tick the “SHOW IN 
OSD” box. See section later in manual for more details. 

7.3.4.6.If we tick “SHOW IN EXPORT” then this event would, by default, be 
exported as part of the published report, however this can be 
overwritten when it comes to designing the report. See section on 
“Publishing” for more details. 
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7.3.4.7.Once we have ticked the required boxes, click “APPLY”, you will 
now see the new code in the table. 
  
 

TIP; if we had tried to use the code “CF” the system would have 
alerted us that this code is already in use, it is the “Clip File” code, and 
so we would not be able to use it. As shown below 
  
 

7.3.4.8. Let’s create another new “User Event”, we will call it “D1” and give 
it a description of “Debris”. 

7.3.4.9. Click the “ADD” button and type “D1” in the “EVENT” window, 
now type “Debris” in the “DESCRIPTION” box. Now let’s look at 
the properties we want to allocate to this event type. 

7.3.4.10. “INCLUDE IN LOG” – Yes 
7.3.4.11. “IS ANOMALY” some debris will be considered an anomaly e.g. an 

anchor on a pipeline, however a sand bag under a platform might not 
be considered an anomaly, so lets say NO here 

7.3.4.12. “SHOW IN OSD” – Yes, if an overlay is connected. 
7.3.4.13. “SHOW IN EXPORT” – Yes. 
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7.3.4.14. Click Apply to close the window 
 
Below is the table with the two new events. 
  

7.3.5. Click "CLOSE" to save the new User Events 
 
Once we get to the button configuration, we will see the affect of setting 
codes as being “IS ANOMALY” OR NOT. 
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8. Selecting a Project 
 
Once the system has been configured we are ready to prepare a project which can 
either be a new project or an already existing one. 
 

8.1. With the DDL GUI running, click on the “Project” tab 
8.2. For a new project select “New Project” from the menu. This will open a new 

window called "Create New Project", see image below. 
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Note there are no "Project Names" in the "Existing Projects" box. 
 

8.2.1. Fill in the required information in the """NEW" Project" box 
8.2.2. Give the project a name; we have used "First Project" as the name. 
8.2.3. Add a "prefix" name e.g. "First" or other text for each media type of 

media file; this name will appear on all the media files for this project. 
8.2.4. If you want to add date and time to the file name then tick the "ADD 

DATE/TIME boxes 
8.2.5. Fill in the other data  

 
  
  
  

accordingly. Here is an example 
 
 

 
 
 

8.2.6. Click "Create" to finish 
 

You will now see the name of the project above the tab line, but no dive has been 
selected so the title says “Dive = No Dive selected”. 
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8.3. Copy existing project 
 
If there is an existing project (First Project), from which you want to copy all the 
names, events and button configurations, then; 
 

8.3.1. Click on the project name you want to "copy" in the list; in this example 
the only one is "First Project", so click on this. 

8.3.2. Tick the "Populate New Project info from selection" box. 
 
The system will now populate the "New Project" with the names from the 
"First Project", give this second project a new name e.g. "Second Project". 
 
Tip: copying a "Project" not only copies the names etc, but also copies the 
configuration, had we set up "user event" codes or configured the 
"Buttons" this data would also be copied into the new project. 
 

8.3.3. Change the Media files "Prefix" to "Second" to reflect the new project 
name. 

8.3.4. Click "Create" to close the 
window. 
Tip; up to the point that you click 
"Create" you can clear all the data 
by clicking "Clear Form". 
Note: when you create a new 
project then click "Create" DDL 
then opens that project 
automatically, even if you were in 
a different project before; however 
the other project is still "open". So 
you will now see, from the page 
header, that we are in Project = 
Second Project............. 
 

8.4. You can Edit Project data at any time by 
clicking on the “Edit Project” title in the “Project” tab. 

8.5. When a project is finished you can close it by choosing “Close Project” in the 
“Project” menu, but this is not a requirement, however it is good file 
management. 
The next step is to configure the "Event Buttons" for the project. This should be 
done prior to opening a Dive. 

8.6. If you want to select an existing project 
8.6.1. click on the “Project” tab 
8.6.2. chose “Select Project” from menu 
8.6.3. then select the project name 
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9. Event Buttons - overview 
 
The "Event Buttons" are configurable, each one can be set to perform one or several 
functions. In this section we will look at the different functions available for 
programming these buttons and use. 
 
NOTE; Configuring the event buttons prior to selecting a project stores the 
configuration in the root data base, configuring the buttons with a project open stores 
the configuration in the Project's Button configuration. 
 
9.1. To configure the "Event Buttons" click on the "Project" tab. 

 

 
 

9.2. Then select "Customise Event Buttons", you will now see the table below. 
  

9.3. 
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9.3. General description of table 
 
The "Customise Event Buttons" table consists of a number of columns, some are 
purely tick boxes others have drop down menus and others are text fields. There 
are 22 numbered buttons and one button called "Manual", this is for manual 
events. We shall look at each column in depth here. 
 

9.3.1. Button text 
 
Column 1 (EVENT (BUTTON NAME)) of the "Customise Event 
Buttons" screen shows the text allocated to each button. By default the 
text in each button is "Button xx" where "XX" is the number of the 
button, except for the most basic operations this nomenclature would not 
be of much use so we can change the name of each button by simply 
highlighting the existing text and over writing it. The text we write on the 
button will be seen "in" the button on the DDL GUI. This text should be a 
short description (max 20 characters) of the event the button relates to e.g. 
"ROV in Water" or "Crack" 
 

9.3.2. Event type 
 
Column 2 (ETYPE) allows us to allocate an "Event Type" to the button. 
In section 6.3 we have seen how owe create events, we can now allocate 
each button with a general "EV" code or a specific code of our making 
e.g. the CR code we create for "Crack Found" or "D1" for Debris.  
 
To allocate a different "Event Type" to a button, click the down arrow to 
the right of the existing "Event Type" code and select the new "Event 
Type". 
 
 

9.3.3. Anomaly tick box 
 
Column 3 (ANOM) lets us decide if the action of clicking the button 
should allocate the event as an Anomaly or not. When we created the 
"CR" code we ticked the "Is Anomaly" box, if we allocate an "Event 
Button" as a "CR" event, then the ANOM box beside it will default to 
being ticked, it will also be greyed out indicating that we cannot stop this 
type of event being an anomaly. When we created the "Debris" code 
"D1", we did not tick the "Is Anomaly" box, so the ANOM box is un-
ticked, however some debris may be considered as anomalous so we 
could have more than one Debris button for different types of debris.  
 
Here is an example; if we name button 01 as "Soft Debris" and button 02 
as "Hard Debris" we could make the "Hard Debris" anomalous by 
clicking the "ANOM" button, but if we leave the "ANOM" button next to 
the "Soft Debris" button then it will not be an anomaly. In this way, the 
same "Event Code" can be used to fine tune the reporting in the log. 
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9.3.4. Workflow 
 
Column 4 (WFLO), when this box is ticked the associated "Event Button" 
will open a new "Work Flow" window in the GUI, this window would 
contain additional instructions for the operator to follow or it may request 
an input of data from the operator. See the section 8.6.2 for more details. 
 

9.3.5. EVENT COMMENT/MESSAGE (EVENT IS USED IF BLANK) 
 

9.3.5.1.Workflow not selected 
 
As described in 8.2 above, each button can have text written on it, this 
would generally be a short form name of the action e.g. "Soft Debris", 
if a more definitive description is required it can be written in the 
"EVENT COMMENT/MESSAGE " cell.  
 
To replace the text, click and highlight the existing text and over write 
it for instance we named a button . "Soft Debris" so the extended 
description may be " Soft debris e.g. sand bag, plastic bucket, nylon 
rope"; this text would then appear in the Log Table for that event. the 
event can be edited to further specify the type of debris found. 
 

9.3.5.2.Workflow selected 
 
If the "Event Button" has it's WFLO box ticked then when the button 
is clicked in the GUI a new window pops up with further instructions. 
These instructions are in two parts part 1 is the instruction and part2  
is the required feedback, the two parts of the text should be separate 
by two vertical lines"||", this character is normally found by pressing 
"Shift" and "\" keys on the keyboard. 
 
An example of a workflow might be; 
 
"Part 1" = "ROV leaving TMS"; "Part 2" "Where is the ROV going?", 
this would be entered as " ROV leaving TMS|| Where is the ROV 
going?" 
 
See section 8.9 "Event Buttons Configuration Shortcut" for more on 
Workflows. 
 

9.3.5.3.Action 
 
Column 6; this is another tick box, it indicates that when the 
associated button is clicked an "Action" will be performed, see section 
8.8 below for more on possible Actions. 
 

9.3.5.4.Actions 
 
Column 7; when the "Action" box is ticked the "Actions" window is 
un-greyed giving access to a drop down menu of possible actions. 
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These actions are "System Events" and as such control the behind the 
scenes working of the DDLR. The list of actions include "73fifty 
trigger" or "Record Start". 
 

9.3.5.5.EDIT 
 
Note at the end of each line there is an EDIT button, clicking this 
brings up an "Button Configuration EDITOR" screen that allows all 
the above parameters to be set from a single screen; this is especially 
useful for setting up Workflows as you do not have to remember to 
include the "||" character. 
 

9.4. Configuring event buttons 
 
Let's configure a few buttons column by column. 
 

9.4.1. Rename "Button 01" as "Deck Checks" 
9.4.2. Leave it's "ETYPE as "EV" 
9.4.3. Leave "ANOM" un-ticked 
9.4.4. Leave "WFLOW" un-ticked 
9.4.5. Type " ROV deck checks completed" 
9.4.6. Leave "Action" box un-ticked; this makes the "Actions" box greyed out. 
9.4.7. Rename "Button 02" as "Off deck" 
9.4.8. Leave it's "ETYPE as "EV" 
9.4.9. Leave "ANOM" un-ticked 
9.4.10. Leave "WFLOW" un-ticked 
9.4.11. Type " ROV off deck - not in water" 
9.4.12. Tick "Action" box 
9.4.13. Select "S1 73fifty - Trigger 1 Set " from the drop down menu. this would 

start a 73fifty Black Box. 
9.4.14. Rename "Button 03" as "In water" 
9.4.15. Change "ETYPE" to "WI" from the drop down list.  
9.4.16. Leave "ANOM" un-ticked 
9.4.17. Leave "WFLOW" un-ticked 
9.4.18. Type " ROV in water - start of billing" 
9.4.19. Tick "Action" box 
9.4.20. Select "RS record Start" from drop down menu. this will start the main 

DVR recording. 
9.4.21. Rename "Button 04" as "At Site"  
9.4.22. Leave it's "ETYPE as "EV" 
9.4.23. Leave "ANOM" un-ticked 
9.4.24. Leave "WFLOW" un-ticked 
9.4.25. Enter the following into the "Comment" field "ROV at worksite" 



 

NETmc Marine DDL software Manual  Rev1  July 2015       28 of 47 
© NETmc Marine Ltd 2013 
 
 

9.4.26. Leave "Action" box un-ticked; this makes the "Actions" box greyed out. 
 
This is how the screen should be looking now: 
 

9.4.27. Rename "Button 05" as "Out of TMS" 
9.4.28. Leave "ANOM" un-ticked 
9.4.29. Tick the "WFLOW" box; NOTE the "Comments" field goes yellow, this 

is to indicate it is a workflow field. 
  

REMEMBER: there are two parts to a Work Flow event separated by "||". 
 



 

NETmc Marine DDL software Manual  Rev1  July 2015       29 of 47 
© NETmc Marine Ltd 2013 
 
 

9.4.30. Click in the "Comments" field and type "ROV out of TMS||Where are you 
going?" We will see how this looks in the log later in the manual. 

9.4.31. Leave "Action" box un-ticked; this makes the "Actions" box greyed out. 
9.4.32. Rename "Button 06" as "At TDP" 
9.4.33. Leave "ETYPE" as "EV" 
9.4.34. Leave "ANOM" un-ticked 
9.4.35. Tick "WFLO" box 
9.4.36. Click in "Comments" field and type "ROV at Touch down point||How far 

from pipe is ROV?" 
9.4.37. Leave "Action" box un-ticked; this makes the "Actions" box greyed out. 
9.4.38. Rename "Button 07" as "Debris" 
9.4.39. Change "ETYPE" to D1, remember we created an event called "D1" 

"Debris" in the "User Events" section of the "Configure" tab. 
9.4.40. Tick the "ANOM" box 
9.4.41. Tick the "WFLO" box 
9.4.42. Type "Debris found on route?||List type of debris - has it been cleared?" 
9.4.43. Tick "Action" 
9.4.44. Select "PX Still Image" 
9.4.45. Rename "Button 08" as "Crack Found" 
9.4.46. Change "ETYPE" to "CR", we created this event earlier 

 
NOTE: "ANOM" tick box is already ticked as we configured the "CR" event 
type this way, it is also greyed out so cannot be un-ticked. 
 

9.4.47. Tick "WFLOW" 
9.4.48. Type "Crack found in pipe?||STOP laying -visually inspect - log thickness 

of crack" 
9.4.49. Tick "Actions" box  
9.4.50. Select "CS Clip Start" from drop down menu 
9.4.51. Rename "Button 9" as "Left Site" 
9.4.52. Leave "ETYPE" as "EV" 
9.4.53. Leave "ANOM" un-ticked 
9.4.54. Leave "WFLO" un-ticked 
9.4.55. Type "ROV left worksite, returning to TMS" in "Comments" field. 
9.4.56. Leave "Action" box un-ticked; this makes the "Actions" box greyed out. 
9.4.57. Rename "Button 10" as "In TMS" 
9.4.58. Leave "ETYPE" as "EV" 
9.4.59. Leave "ANOM" un-ticked 
9.4.60. Leave "WFLO" un-ticked 
9.4.61. Type "ROV secured in TMS ready for recovery to surface 
9.4.62. Leave "ETYPE" as "EV" 

 
Leave Buttons 11-20 unchanged, this will allow us to add events later if required, 
 
9.4.63. Rename "Button 21" as "ROV on Surface" 
9.4.64. Leave "ETYPE as "WO" 
9.4.65. Leave "ANOM" un-ticked 
9.4.66. Tick "WFLO" box 
9.4.67. Type "ROV on surface||record weather conditions" in the comment box. 
9.4.68. Tick "Action Box" 
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9.4.69. Select "RE Record End" 
9.4.70. Rename "Button 22" as "ROV on Deck" 
9.4.71. Leave "ETYPE as "EV" 
9.4.72. Leave "ANOM" un-ticked 
9.4.73. Tick "WFLO" box 
9.4.74. Type "ROV on deck||post dive checks complete? 
9.4.75. Tick ""Actions" button 
9.4.76. Select "CL 73fifty-Trigger1 Close"; this will stop the 73fifty Black Box. 
9.4.77. Finally rename "Button 23" as "Manual Event" 
9.4.78. Leave all other fields of "Button 23" as they are. 

 
The screen should now look like the picture below. 

 
 
NOTE: the "Button Configuration Name" window, the name "ROOT 
Default" is the system default name for the project button configuration, as 
we have now changed the configuration of the buttons, if we click "Apply" 
the "Root Default" button will also be changed. If we want to keep the 
default settings for the buttons configuration, we can change the "Button 
Configuration Name" and "Save" it as a different file, we will cover this 
later in this section. 
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9.4.79. Click on "Apply" to save and load the new configuration. 
 
You should now be back at the main screen as shown below. 
  
  
  
  
  
  
  

NOTE: the buttons are still greyed out, this is because we have not yet 
selected a dive. Before we select a dive let's look at a short cut to 
configuring the buttons. 
 

9.5. Using the "EDIT" button 
 
As seen above each parameter in the "Customise Event Buttons" screen can be 
configured individually, however if you double click on the  "EDIT" button at 
the end off each line then a new window pops up as below. 
 
 



 

NETmc Marine DDL software Manual  Rev1  July 2015       32 of 47 
© NETmc Marine Ltd 2013 
 
 

As you can see it is possible to configure all button functions from within this 
screen, from changing the Button's name to selecting an "Action". 
 
 
To describe this window let's amend "Button 11" of the current button 
configuration. 
 

9.5.1. Click the "Project" tab then select "Customise Event Buttons" 
9.5.2. Double Click in the "EVENT COMMENT/MESSAGE" field of Button 

11, this will open the window for this event. 
 
Tip: Event Buttons can be customised at any point in a Project, so the 
Buttons do not have to be configured in the order that they would be used, 
though of course this would be best. 
  
 

9.5.3. Rename Button 11 as "First TDP" 
9.5.4. Leave the Event Type as EV, a general event. 
9.5.5. Leave the Anomaly box un-ticked 
9.5.6. Tick the "NONE" box beside the WorkFlow title 

 
Note: you cannot click in the first box "Message/Action" text box; this is 
because we have selected NONE above. 
 

9.5.7. Click in the "FEEDBACK/Comment" box 
9.5.8. Enter the text "Anode touchdown point" 
9.5.9. Tick the Enable Action box 
9.5.10. Select PX from the drop down menu beside the tick box. 
9.5.11. Click apply 
9.5.12. Click on the "Edit" button for button 12 
9.5.13. Rename "Button 12" as "Pipe No." 
9.5.14. Leave the Event Type as EV, a general event. 
9.5.15. Leave the Anomaly box un-ticked 
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9.5.16. Tick the "Message/Action" box beside the WorkFlow title 
 
Note: you can now click in the first box "Message/Action" text box 
 

9.5.17. Click in the "Message/Action" box. 
9.5.18. Type "Enter the pipe ID number painted on the pipe" 
9.5.19. Click in the "FEEDBACK/Comment" box 
9.5.20. Enter the text "Pipe ID No. = ???"; the ??? tells the system that there 

should be a response to this question; if no answer is input, then DDL will 
check how you wish to proceed. 

9.5.21. Tick the Enable Action box 
9.5.22. Select PX from the drop down menu beside the tick box. 

 
The screen should now be as shown; 
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9.5.23. Click apply 
 
The screen should now look like this: 
 

 
Notice the "Comments" field of "Button 11" has a white background, where 
as that of "Button 12" is yellow, this is because "Button 12" has a Question 
and a required Feedback. Also note the character "||" has automatically been 
inserted in the "Comments" field for "Button 12" thus indicating a response 
is required. 
 

9.5.24. Now Click "Apply" to close the "Customise Event Button" screen.    
 
Now let's select a dive and start to use the DDL software. 
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10. Selecting a Dive 
 
10.1. From the main screen click on the "Dive" tab. 
10.2. Click on "New Dive". A new window will open, the top of this indicates the 

dive will be in "Project [Second Project], it also shows that there are no 
other dives in the project and that the "New Dive" will be called "Dive-
001": see image below. 

 
 
Note; all the Project data has automatically been copied into the window for 
you, as has the Project media prefix names, in this case "Second" 
 

10.3. You can give the dive a friendlier name than "Dive-001" if you wish e.g. 
"Touchdown Monitoring" as we have used in the example below. 
 

10.4. You can now add a media prefix specific to this dive if required, we will use 
"TDM" 
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10.5. Now click "Create New" to finalise the new dive. 
 
NOTE: shown below, the Buttons are no longer greyed out and the title bar 
indicates the project name and dive name. 

 
 
 

11. Summary of configuration 
 
So far we have seen how to: 
 

• set up a file structure for the DDL project tree 
• select the bit rate and input to the DVR 
• configure the various DDL options 
• create and configure "User Events" 
• set actions 
• configure "Event Buttons" both column by column and via the "Button Configuration 

Editor" 
 
It is now time to start using the "Eventing Buttons" to populate the Log Table. 
 
 



 

NETmc Marine DDL software Manual  Rev1  July 2015       37 of 47 
© NETmc Marine Ltd 2013 
 
 

12. Using the "Event Buttons" 
 
REMEMBER for the media controls to work there must be a video source connected. 
If you do not see a video picture on the screen STOP and check the source before 
proceeding. 
 
12.1. Click button "Deck Checks"; note in the log this generates an entry called 

"001", subsequent Button clicks will generate sequentially numbered events.  
 
Note; no media recordings have been instigated as this button had no actions 
associated to it. 
 
Move the slider at the bottom of the screen to see cells further to the right; 
"right" clicking on any of the columns displays a drop down list of possible 
parameters to be displayed, see below. 
 
 

12.2. Click "Off Deck"; this has generated "S1" in the "A" (Actions) column 
indicating that it would start a 73fifty if connected. 
 
NOTE; 73fifty media file names are NOT displayed in the log table. 
 

12.3. Click "In Water";  
 
Note this button was configured to start the master recording, see "Record 
Controls" section on the right of the screen; you can see the duration of the file 
counting up and the name of the file that includes the Project and Dive prefixes 
that we set up earlier. 
 
Remember; the duration of these files is dependent on the settings in the 
configuration screen, currently this is set to 5min (300secs) 
Also note the Log Table has an entry 004, this is a "System Event" and 
indicates the DVR has started recording. 
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12.4. Click "At Site" 
12.5. Click "Out of TMS" button 

 
This pops up the "WorkFlow" window with the cursor blinking in the 

"Feedback" box as shown below. 
 
 

12.6. Enter the ROVs destination in the "Feedback" box, we have entered "Touch 
down point". 
 
There are two other tabs in this window 
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12.6.1. Click on the "Recording Clips and Stills" tab; this shows if any media 
files were open, or have been opened, when the event button was clicked. 
 
 
e.g. here we are advised that a file "SecondTDM20130722160050.avi was 
in progress when the event occurred and that the event happened 57.13 
seconds into the file. If the event button was clicked too late, and the 
recorder was recording at the earlier time, then clicking the "Allow Edit" 
tick box enables you to look at the video file and change the "Time Code" 
(TC) of the event. By doing this if you play the media from within the log, 
the video will start at the TC of the event, rather than at the start of the 
video file. 
 
In the example above, change the TC of the event to 56:1, see below. 
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12.6.2. Click "Event Summary"; this is effectively a preview of what will be 
logged in the Log Table. 
  

12.6.3. Tick the "Allow Edit Of Event Time"; you can now change the time of the 
event if critical. 

12.6.4. If no editing of the event is required click "Apply" 
 
The screen should now look as follows: 
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13. Manual eventing 
 
There is more than one way to add a manual event to the log and these depend on the 
settings in the "Options" screen under the "Configure" Tab. Let's quickly look in the 
"Options" screen; 
 

 
Currently the "Always Edit Manual log event........" is ticked, so when we click on the 
"Manual EVENT" screen. 
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13.1. Click on the "Manual Event" button to create entry 007. 
 
  

This now allows us to edit the manual event, including changing the Time 
Code of any associated media files. 
  

13.2. To create the next log entry click "Add Time event" the box below will 
appear. 
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Tip; you can now watch the clock and click "Add" when the event happens for higher 
accuracy, e.g. timing the touch down of a jacket during installation. 
 
Tip: this event window can be kept open and running in the background for instant 
access. 
 
13.3. Click "ROV on surface" and record the weather conditions 
13.4. Click "ROV on deck" and answer the question. 
13.5. Optionally you can close the Dive from the "Dive" tab. When you do this the 

buttons are greyed out. 
13.6. Optionally you can close the Project from the "Project" tab. The header at the 

top of the screen no says Project = No Project .............. 
13.7. Editing existing events 

 
At any point during the operation an event can be edited, just right click on 
the event and select "Edit Event." 
 

 
14. Configuring the NETmc Marine videoTXT overlay 

 
As previously stated when setting up new "User Events" DDL can control an external 
NETmc Marine videoTXT overlay. NB the DDL overlay control only works with 
NETmc Marine videoTXT overlay, it does not work with other 3rd party overlays.    
In this section we will look at how to configure the On Screen Display or OSD. 
 
14.1. Click on the "Overlay" tab to display the sub-menu; here you can enable or 

disable the OSD, and select what parameters to be show. However it is 
probably best to configure the overlay from the "Setup Overlay" option. 

14.2. Click on "Setup Overlay" and the box below opens. 
 
  



 

NETmc Marine DDL software Manual  Rev1  July 2015       44 of 47 
© NETmc Marine Ltd 2013 
 
 

14.3. Screen Description 
 

14.3.1. "Advanced Settings" 
This allows the overriding of the default figure. 

14.3.2. "Enable Overlay" 
Tick this box to enable the use of the overlay. Beside this is a COM port 
window, this should always be COM1. 

14.3.3. "Automated Template Page" 
If the user saves a template configuration, and want to use this as a default 
then tick this box. 

14.3.4. "Add Time &Date" 
Tick this box to display the overlay generated time and date if neither the 
ROV or the NAV system does not generate it. 
 
Tip: the overlay generated time and date will, by default, be positioned 
top left, left justified. To move the position of the overlay click on any 
part of the numbers and drag to the preferred position. 
 
NOTE: where the time and display shows up on the screen will depend on 
the width and height settings in the Advanced Screen. 
 

14.3.5. "Add Label" 
The overlay screen can be used to give the video feed a name e.g. 
"Centre Camera". To the right of the text field is a drop down menu, this 
gives the ability to select where to display the "Label"; Left, centre or 
right. 

14.3.6. "Display Event on Overlay" 
When ticked, an event configured to be displayed in OSD will have the 
text from its button displayed on the screen. 

14.3.7. "Display Event Comment on Overlay" 
When ticked, an event configured to be displayed in OSD will have the 
text from its comment field displayed on the screen. 

14.3.8. "Enable AutoClear" 
If this button is ticked then the display parameters will clear from the 
overlay after the predetermined time, otherwise they will have to be 
manually deleted. 

14.3.9. The load and save buttons are to use previously stored overlay settings. 
14.3.10. "Reset" 

If after making changes, but before applying them, you want to cancel 
them, click "Reset". 
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15. Manual control of media 
 
On the right hand side of the event log is the 
"Record Control" section, the controls will 
change as a relevant event button is pressed, 
however the controls can be manually 
operated as well, though only if a "Project" 
and "Dive" are selected. 
 
15.1. The buttons are operated by simply 

clicking on the relevant function. 
15.2. Replay media files from the "Record 

Control" listing 
 
All media files can be replayed 
immediately after the file is 
completed.  During replay, the file 
replaces the live view, at any time the 
"LIVE VIEW" button can be clicked 
to revert to showing the live view. 
 
The file is played by clicking on the 
file name in the "Record Control" area 
or from the log table. As seen in the 
image here the "Playback" turns blue 
when media files are played, in normal 
mode the "Live View" button would 
be blue. The image here shows a 
"Still" being displayed, if the file were 
a video file the "Play" button would 
change to a "Pause" button. You can 
use the slide bar to move back and 
forward in the video file or for finer 
control use the left and right arrow 
keys. 
 
Tip: If you enable the display screen 
in the log, then the media files can be 
played and the live view can be seen at the same time. 
 

15.3. Replay media files from log table 
 
It may be easier to locate a media file by an "event" in the log, to do this you can 
locate the event in the log then find the media file you want and play it. To play 
the file right click on the cell containing the media file and click the relevant 
command.  
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In the image above, "Open Record Media" has been selected, look at the time 
code boxes below the counter screen, there are two one is called "Len" this is the 
duration of the files selected, the other box is called "Evt @" this indicates that 
there is an "Event" at the displayed time "into" the file.  
 
In this example, the event is 8s into the file which is 15s long. When we play this 
file in this manner, the player jumps straight to the event time. Of course you can 
use the arrow keys or slide bar to go backwards in the file. 
 

16. Publishing reports 
 
Under the "Publish" tab is the facility to generate reports, these can be either Docx; 
CSV or HTML format. Each format has a default template that controls the layout of 
the report and how the logged data is used. 
 
TIP: you must have a project open to be able to access the "Publish" menu. 
 
To generate a report click on the "Publish" 
tab, there are now several options to choose 
from. 
 
16.1. Run Report (Current Report) 

 
If a report has already been used, or 
selected, the report name will be 
displayed in the brackets, just click 
"Run Report" to generate the report. 
The system then displays a compiler 
screen and asks where to save the 
report.  
 
NOTE: the reports generated will all have the same default name, so suffix the 
file name with the time and date generated before saving to identify each report. 
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16.2. New Template 
 
NOTE: this is not a function field staff would normally use. More normally 
field staff would use the "Edit Template" function, however these templates 
will probably be set by the ROV management. 
 
The "New Template" option allows you to use an EXISTING template and 
modify the data displayed in the report it generates and save this as a separate 
template for a new report, with a new name. DO NOT use this function to edit a 
template which is going to keep the same name, for this use the "Edit 
Template" function. 
 

16.2.1. Select the type of report you want 
HTML (XSL Transform), CSV 
(ASCII) or Microsoft DOCX. 

16.2.2. Browse to select the template you 
want to use and select it. 
 
 
 
 
 
 
 
 

16.2.3. Select the type of events you want to be included in the report 
16.2.4. Give the report a new name and "Create" the report template 

 
16.3. Edit Template 

 
This allows you to change the events to be displayed in the selected report; the 
one whose name is in the brackets beside the "Run Report) option. 
 

16.4. Delete Template 
Select this option to delete unwanted templates. 
 
NOTE: You must always have at least one template. 
 

16.5. Export DiveLog 
 
This section enables the user to generate an HTML report, viewable in Internet 
Explorer or a bundled version with hyperlinks to media files. 


